
 

 

  

 

 
Lenguaje Específico de Dominio 

GIDAS – UTN Facultad Regional La Plata 

Autores: 
Caputti, Matías 

Zugnoni, Iván 
Rocca, Leandro 

PID: Herramientas de soporte a la Ingeniería de Requisitos Dirigida por Modelos: 
desde las necesidades de negocio hacia los requisitos de software 

 
DIRECTOR: Leopoldo NAHUEL  |  CODIRECTOR: Roxana Giandini 



 

Tabla de contenidos 

Instalaciones necesarias ...................................................................................................................... 3 

Java JDK 7.u78 (64-bit) ................................................................................................................................. 3 
Eclipse Classic SDK 4.2.2 JUNO (64 bits)........................................................................................................ 3 

Modificar archivo eclipse.ini, con la ruta y versión de JRE instalada ................................................... 4 

Instalación paquete “Modeling” ......................................................................................................... 4 

Actualizar paquetes ...................................................................................................................................... 5 

Nuevo proyecto para crear herramienta gráfica ................................................................................. 6 

Creación del Metamodelo ................................................................................................................... 7 

Vista textual del Metamodelo (.ecore) ......................................................................................................... 8 
Vista gráfica del Metamodelo (.ecore_diagram) ........................................................................................ 10 

Crear herramienta gráfica para instanciar un Modelo ...................................................................... 11 
Domain Model (.ecore) .............................................................................................................................. 11 
Domain Gen Model (.genmodel) ................................................................................................................ 12 
Graphical Def Model (.gmfgraph) ............................................................................................................... 14 
Tooling Def Model (.gmftool) ..................................................................................................................... 15 
Mapping Model (.gmfmap) ........................................................................................................................ 17 
Diagram Editor Gen (.gmfgen) .................................................................................................................... 19 

Ejecutar la herramienta modeladora gráfica ..................................................................................... 20 

Crear un nuevo modelo gráfico ......................................................................................................... 21 
Código ejemplo default.dslsalud ................................................................................................................ 24 
Código ejemplo default.dslsalud_diagram ................................................................................................. 24 

 

  



 

PARTE 1 

Instalaciones necesarias 
 

Java JDK 7.u78 (64-bit) 
http://www.oracle.com/technetwork/java/archive-139210.html  

 

 

Eclipse Classic SDK 4.2.2 JUNO (64 bits) 
https://eclipse.org/downloads/packages/eclipse-

classic-422/junosr2  

 

 

 

  

http://www.oracle.com/technetwork/java/archive-139210.html
https://eclipse.org/downloads/packages/eclipse-classic-422/junosr2
https://eclipse.org/downloads/packages/eclipse-classic-422/junosr2


 

Modificar archivo eclipse.ini, con la ruta y versión de JRE instalada 
 
-startup 

plugins/org.eclipse.equinox.launcher_1.3.0.v20120522-1813.jar 

-vm 

C:/Program Files/Java/jre7/bin/javaw.exe 

--launcher.library 

plugins/org.eclipse.equinox.launcher.win32.win32.x86_64_1.1.200.v20120913-144807 

-showsplash 

org.eclipse.platform 

--launcher.XXMaxPermSize 

256m 

--launcher.defaultAction 

openFile 

-vmargs 

-Xms40m 

-Xmx512m 

 

-startup 

../../../plugins/org.eclipse.equinox.launcher_1.3.0.v20120522-1813.jar 

--vm 

/Library/Java/JavaVirtualMachines/jdk1.7.0_80.jdk/Contents/Home/bin/java 

--launcher.library 

../../../plugins/org.eclipse.equinox.launcher.cocoa.macosx.x86_64_1.1.200.v20120913-144807 

-showsplash 

org.eclipse.platform 

--launcher.XXMaxPermSize 

256m 

--launcher.defaultAction 

openFile 

-vmargs 

-Xms40m 

-Xmx512m 

-Xdock:icon=../Resources/Eclipse.icns 

-XstartOnFirstThread 

-Dorg.eclipse.swt.internal.carbon.smallFonts 
 

En MacOS para iniciar Eclipse, desde la consola: 

./eclipse/Eclipse.app/Contents/MacOS/eclipse 

Instalación paquete “Modeling” 
 



 

Help > Install new software  

Work with: Juno – http://download.eclipse.org/releases/juno 

Search: Modeling 

Seleccionar todo el paquete Modeling y “Next” 

 

 

Actualizar paquetes 
 

Help > Check for updates  

 

  

http://download.eclipse.org/releases/juno


 

Nuevo proyecto para crear herramienta gráfica 
 

File  > New > Other > Graphical Modeling Framework > Graphical editor Project 

Ingresar un nombre para el proyecto y “Finish”  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  



 

Creación del Metamodelo 
 

File  > New > Other > Graphical Modeling Framework > Ecore Model 

Ingresar un nombre para el metamodelo y “Finish” 

 

 

Tener en cuenta que se tuvo que utilizar una clase superior DSLSalud dentro del metamodelo, la cual mediante 

agregación contiene las demás clases, ya que luego para modelar gráficamente se tomará una clase como punto de 

anclaje de entrada, y se permitirá graficar todas las clases que contengan dependencias desde la misma. 

 

 

 



 

Vista textual del Metamodelo (.ecore) 
 
<?xml version="1.0" encoding="UTF-8"?> 
 
<ecore:EPackage xmi:version="2.0" xmlns:xmi="http://www.omg.org/XMI" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance" 
    xmlns:ecore="http://www.eclipse.org/emf/2002/Ecore" name="dslsalud" nsURI="gidas.frlp.utn.edu.ar" nsPrefix="dslsalud"> 
 
  <eClassifiers xsi:type="ecore:EClass" name="DSLSalud"> 
    <eStructuralFeatures xsi:type="ecore:EAttribute" name="name" eType="ecore:EDataType 
http://www.eclipse.org/emf/2002/Ecore#//EString"/> 
    <eStructuralFeatures xsi:type="ecore:EReference" name="hasPersons" upperBound="-1" 
        eType="#//Person" containment="true"/> 
    <eStructuralFeatures xsi:type="ecore:EReference" name="hasOrganizations" upperBound="-1" 
        eType="#//Organization" containment="true"/> 
    <eStructuralFeatures xsi:type="ecore:EReference" name="hasEncounters" upperBound="-1" 
        eType="#//Encounter" containment="true"/> 
    <eStructuralFeatures xsi:type="ecore:EReference" name="hasEpisodesOfCare" upperBound="-1" 
        eType="#//EpisodeOfCare" containment="true"/> 
  </eClassifiers> 
 
  <eClassifiers xsi:type="ecore:EClass" name="Person" abstract="true"> 
    <eStructuralFeatures xsi:type="ecore:EAttribute" name="active" eType="ecore:EDataType 
http://www.eclipse.org/emf/2002/Ecore#//EBoolean"/> 
    <eStructuralFeatures xsi:type="ecore:EAttribute" name="address" eType="ecore:EDataType 
http://www.eclipse.org/emf/2002/Ecore#//EString"/> 
    <eStructuralFeatures xsi:type="ecore:EAttribute" name="birthDate" eType="ecore:EDataType 
http://www.eclipse.org/emf/2002/Ecore#//EString"/> 
    <eStructuralFeatures xsi:type="ecore:EAttribute" name="gender" eType="ecore:EDataType 
http://www.eclipse.org/emf/2002/Ecore#//EInt"/> 
    <eStructuralFeatures xsi:type="ecore:EAttribute" name="identifier" eType="ecore:EDataType 
http://www.eclipse.org/emf/2002/Ecore#//EInt"/> 
    <eStructuralFeatures xsi:type="ecore:EAttribute" name="name" eType="ecore:EDataType 
http://www.eclipse.org/emf/2002/Ecore#//EString"/> 
    <eStructuralFeatures xsi:type="ecore:EAttribute" name="surname" eType="ecore:EDataType 
http://www.eclipse.org/emf/2002/Ecore#//EString"/> 
    <eStructuralFeatures xsi:type="ecore:EAttribute" name="telecom" eType="ecore:EDataType 
http://www.eclipse.org/emf/2002/Ecore#//EString"/> 
  </eClassifiers> 
 
  <eClassifiers xsi:type="ecore:EClass" name="Patient" eSuperTypes="#//Person"> 
    <eStructuralFeatures xsi:type="ecore:EAttribute" name="maritalStatus" eType="ecore:EDataType 
http://www.eclipse.org/emf/2002/Ecore#//EInt"/> 
    <eStructuralFeatures xsi:type="ecore:EAttribute" name="deceased" eType="ecore:EDataType 
http://www.eclipse.org/emf/2002/Ecore#//EBoolean"/> 
  </eClassifiers> 
 
  <eClassifiers xsi:type="ecore:EClass" name="Practitioner" eSuperTypes="#//Person"> 
    <eStructuralFeatures xsi:type="ecore:EAttribute" name="qualification" eType="ecore:EDataType 
http://www.eclipse.org/emf/2002/Ecore#//EInt"/> 
  </eClassifiers> 
 
 
 
 
 
 
 
 



 

  <eClassifiers xsi:type="ecore:EClass" name="Organization"> 
    <eStructuralFeatures xsi:type="ecore:EAttribute" name="active" eType="ecore:EDataType 
http://www.eclipse.org/emf/2002/Ecore#//EBoolean"/> 
    <eStructuralFeatures xsi:type="ecore:EAttribute" name="address" eType="ecore:EDataType 
http://www.eclipse.org/emf/2002/Ecore#//EString"/> 
    <eStructuralFeatures xsi:type="ecore:EAttribute" name="alias" eType="ecore:EDataType 
http://www.eclipse.org/emf/2002/Ecore#//EString"/> 
    <eStructuralFeatures xsi:type="ecore:EAttribute" name="identifier" eType="ecore:EDataType 
http://www.eclipse.org/emf/2002/Ecore#//EInt"/> 
    <eStructuralFeatures xsi:type="ecore:EAttribute" name="name" eType="ecore:EDataType 
http://www.eclipse.org/emf/2002/Ecore#//EString"/> 
    <eStructuralFeatures xsi:type="ecore:EAttribute" name="telecom" eType="ecore:EDataType 
http://www.eclipse.org/emf/2002/Ecore#//EString"/> 
    <eStructuralFeatures xsi:type="ecore:EAttribute" name="type" eType="ecore:EDataType 
http://www.eclipse.org/emf/2002/Ecore#//EInt"/> 
    <eStructuralFeatures xsi:type="ecore:EReference" name="serviceProvider" lowerBound="1" 
        upperBound="-1" eType="#//Encounter"/> 
  </eClassifiers> 
 
  <eClassifiers xsi:type="ecore:EClass" name="Encounter"> 
    <eStructuralFeatures xsi:type="ecore:EAttribute" name="class" eType="ecore:EDataType 
http://www.eclipse.org/emf/2002/Ecore#//EInt"/> 
    <eStructuralFeatures xsi:type="ecore:EAttribute" name="identifier" eType="ecore:EDataType 
http://www.eclipse.org/emf/2002/Ecore#//EInt"/> 
    <eStructuralFeatures xsi:type="ecore:EAttribute" name="length" eType="ecore:EDataType 
http://www.eclipse.org/emf/2002/Ecore#//EInt"/> 
    <eStructuralFeatures xsi:type="ecore:EAttribute" name="periodFinish" eType="ecore:EDataType 
http://www.eclipse.org/emf/2002/Ecore#//EString"/> 
    <eStructuralFeatures xsi:type="ecore:EAttribute" name="periodStart" eType="ecore:EDataType 
http://www.eclipse.org/emf/2002/Ecore#//EString"/> 
    <eStructuralFeatures xsi:type="ecore:EAttribute" name="priority" eType="ecore:EDataType 
http://www.eclipse.org/emf/2002/Ecore#//EInt"/> 
    <eStructuralFeatures xsi:type="ecore:EAttribute" name="status" eType="ecore:EDataType 
http://www.eclipse.org/emf/2002/Ecore#//EInt"/> 
    <eStructuralFeatures xsi:type="ecore:EAttribute" name="type" eType="ecore:EDataType 
http://www.eclipse.org/emf/2002/Ecore#//EInt"/> 
    <eStructuralFeatures xsi:type="ecore:EReference" name="subject" lowerBound="1" 
        eType="#//Patient"/>  
    <eStructuralFeatures xsi:type="ecore:EReference" name="episodeOfCare" lowerBound="1" 
        upperBound="-1" eType="#//EpisodeOfCare"/> 
  </eClassifiers> 
 
  <eClassifiers xsi:type="ecore:EClass" name="EpisodeOfCare"> 
    <eStructuralFeatures xsi:type="ecore:EAttribute" name="identifier" eType="ecore:EDataType 
http://www.eclipse.org/emf/2002/Ecore#//EInt"/> 
    <eStructuralFeatures xsi:type="ecore:EAttribute" name="periodFinish" eType="ecore:EDataType 
http://www.eclipse.org/emf/2002/Ecore#//EString"/> 
    <eStructuralFeatures xsi:type="ecore:EAttribute" name="periodStart" eType="ecore:EDataType 
http://www.eclipse.org/emf/2002/Ecore#//EString"/> 
    <eStructuralFeatures xsi:type="ecore:EAttribute" name="status" eType="ecore:EDataType 
http://www.eclipse.org/emf/2002/Ecore#//EInt"/> 
    <eStructuralFeatures xsi:type="ecore:EAttribute" name="type" eType="ecore:EDataType 
http://www.eclipse.org/emf/2002/Ecore#//EInt"/> 
    <eStructuralFeatures xsi:type="ecore:EReference" name="careManager" lowerBound="1" 
        eType="#//Practitioner"/> 
    <eStructuralFeatures xsi:type="ecore:EReference" name="patient" lowerBound="1" 
        eType="#//Patient"/> 
  </eClassifiers> 
 
</ecore:EPackage> 



 

Vista gráfica del Metamodelo (.ecore_diagram) 
 

Cuando el archivo DSLSalud.ecore está listo se puede inicializar el diagrama asociado al metamodelo haciendo clic 

derecho sobre el archivo y apretando la opción “Initialize ecore_diagram file”. Esto nos generará el archivo 

DSLSalud.ecore_diagram. 

Es importante no hacer cambios sobre el diagrama visual, ya que la correlación con el metamodelo XML no es directa y lo 

modificará haciéndolo incompatible con herramientas que se deberán utilizar en pasos posteriores. 

 

  



 

PARTE 2 

Crear herramienta gráfica para instanciar un Modelo 
 

Window > Show view > Other > GMF Dashboard 

 

El dashboard muestra todo el proceso que deberemos realizar para crear una herramienta gráfica que nos permita 

modelar e instanciar un modelo utilizando nuestro metamodelo anteriormente creado. 

 

Domain Model (.ecore) 
 

El primer paso será cargar el metamodelo como Domain Model (.ecore). A partir de este punto todo se “construirá” 

sobre el metamodelo que seleccionemos. Avanzamos con la premisa de que el metamodelo es correcto y contiene todos 

los elementos deseados que esperamos poder utilizar en el plugin graficador. 

Apretando en “Select” y tomamos nuestro metamodelo desde nuestro workspace.  

 
 



 

Domain Gen Model (.genmodel) 
 

Derivaremos nuestro Domain Model hacia un Domain Gen Model (.genmodel) utilizando el botón “Derive”. Esto nos 

creará un modelo de generador de código que nos dará el código de salida de nuestro modelo y permitirá instanciar 

nuestro modelo. Es la base del plugin graficador, aún sin información de diagrama y herramientas que se utilizarán para 

graficar. 

Primero se seleccionará donde guardar, que elegiremos la carpeta model. Luego se seleccionara el tipo de nuestro 

modelo, que será “Ecore model”. 

 

Luego se cargará el metamodelo para que sea validado apretando “Load”. Y finalmente se seleccionará el paquete 

dentro del metamodelo que contiene la información del dominio, en nuestro caso “dslsalud”. 

  

 

 

 



 

Una vez creado el dslsalud.genmodel lo abrimos y verificamos que esté todo el contenido de nuestro metamodelo. 

 

Si está todo bien, apretamos clic derecho sobre la raíz y seleccionamos la opción “Generate All”. 

 

 

Esto nos generará en el workspace el código del Editor, Modelo y Testing del plugin en las carpetas dslsalud.edit, 

dslsalud.editor y dslsalud.tests que utilizaremos utilizaremos más adelante. 

 

 



 

Graphical Def Model (.gmfgraph) 
 

Derivaremos nuestro Domain Model hacia un Graphical Def Model (.gmfgraph) utilizando el botón “Derive”. Esto nos 

creará un modelo de definiciones gráficas que contendrá todos los elementos gráficos a utilizar en nuestro plugin 

graficador. Seleccionamos nuestro metamodelo .ecore y seleccionamos la clase principal para nuestro diagrama, en este 

caso “DSLSalud”, que es la clase extra que agregamos en el metamodelo para tomar como punto de anclaje. 

   
 

Luego marcamos las “entidades”, “relaciones” y “atributos” de nuestro cada clase de nuestro metamodelo. Es importante 

dejar a la clase DSLSalud sin marcar. 

 

Es importante en este punto, mirar con especial la clasificación de “entidades”, “relaciones” y “atributos” que se haga, ya 

que la funcionalidad del editor gráfico dependerá de ello. 

Haciendo clic en “Finish” se creará nuestro Graphical Def Model dentro de nuestro workspace. 

 

 



 

Tooling Def Model (.gmftool) 
 

Derivaremos nuestro Domain Model hacia un Tooling Def Model (.gmftool) utilizando el botón “Derive”. Esto nos creará 

todas las herramientas gráficas en las que se hará clic para dibujar nuestros modelos. Seleccionamos nuestro 

metamodelo .ecore y seleccionamos la clase principal para nuestro diagrama, en este caso “DSLSalud”. 

 

Luego marcamos las “entidades” y “relaciones” de nuestro metamodelo al igual que en el paso anterior. Nótese que 

ahora sólo se puede marcar entre “entidad” y “relación” ya que este archivo de configuración será íntegramente para la 

caja de herramientas, dónde sólo se pueden seleccionar entidades o relaciones.  

   

 

Haciendo clic en “Finish” se crearán las herramientas gráficas Tooling Def Model dentro de nuestro workspace. 

 

 



 

La configuración base que se creó tiene todas las entidades y relaciones en el mismo nivel. Para una major legibilidad, 

abrimos y editamos manualmente al archivo dslsalud.gmftool. 

Lo que se hace es crear dos “Tool Group” haciendo click derecho sobre Palette dslsaludPallete > New Child > Tool Group. 

En el primer grupo pondremos todos los Creation Tools de entidades, y en el segundo todos los de relaciones. Con esto 

nuestra paleta de herramientas estará dividida en dos, con entidades por un lado y relaciones por el otro. 

Como paso extra, reemplazamos los íconos base que cada herramienta tenía por un ícono más representativo en cada 

caso. Esto se hizo modificando la dirección de “Bundle Image” desde sus Propiedades. Los nuevos íconos deben ir en la 

carpeta dslsalud.edit/obj16 y dslsalud.edit/obj32. 

 

 

 

 

 

 

 

 



 

Mapping Model (.gmfmap) 
 

Combinamos nuestro Domain Model (.ecore), Graphical Def Model (.gmfgraph) y Tooling Def Model (.gmftool), utilizando 

el botón “Combine”. Esto nos creará un Mapping Model (.gmfmap) que mapeará cada definición gráfica con una 

herramienta gráfica para luego poder crear un nuevo modelo. 

Este archivo es el más importante del proceso GMF, ya que será el encargado en unir todas nuestras configuraciones 

anteriores. 

Lo primero que se hace es ponerle el nombre dslsalud.gmfmap y que se guarde dentro de la carpeta model. Luego se 

selecciona la clase raíz de nuestro modelo de dominio, en nuestro caso DSLSalud. 

 

 

Luego se selecciona el elemento base del Tooling definition model (dslsalud.gmftool) y su elemento raíz, en nuestro caso 

dslsaludPalette. Finalmente se selecciona el Grafical definition model (dslsalud.gmfgraph) y su elemento raíz, en nuestro 

caso dslsalud. 

 

 



 

Esto nos habrá creado en el workspace un archivo dslsalud.gmfmap. Lo abrimos y veremos que está dividido en 4 

regiones: gmfmap, ecore, gmfgraph, gmftool. 

Abrimos la región gmfmap y modificamos los “Mapping” de forma tal que que todos los “Link Mapping” estén 

correctamente mapeado ya que hasta este momento no configuramos “qué entidad se puede relacionar con qué 

entidad”. 

Los “Top Node Reference” > “Node Mapping” serán las entidades, verificar también que estén todas. 

 

En caso de tener que modificar se hará desde la solapa “Propiedades”, que puede abrirse haciendo clic derecho sobre el 

elemento y abajo de todo apretando la opción “Show Properties View” 

 

 

  



 

Diagram Editor Gen (.gmfgen) 
 

El paso final será apretar el botón “Transform” para compilar y unir todos los archivos en un Diagram Editor Gen Model 

(.gmfgen) y así generar el editor que luego utilizaremos para modelar.  

 

Cuando se cree el archivo dslsalud.gmfgen apretamos sobre el mismo clic derecho y seleccionamos la opción “Generate 

diagram code”. 

 
 

 
 

 

 

 

 



 

Ejecutar la herramienta modeladora gráfica 
 

Clic derecho sobre la carpeta dslsalud.diagram generada > Run as > Eclipse application 

 

Se abrirá una nueva instancia de Eclipse con nuestro plugin graficador pre-cargado. 

Se podrá ver el estado de la ejecución del plugin y finalizarlo apretando el botón rojo de Stop en la pestaña “Consola”. 

  



 

PARTE 3 

Crear un nuevo modelo gráfico 
 

Una vez abierta la nueva instancia de Eclipse tendremos que crear un nuevo proyecto desde  

File > New project > General > Project 

Ingresamos un nombre a nuestro proyecto, en este caso test. 

 

    
 

 

Una vez creado el nuevo proyecto se procederá a crear nuestro diagrama DSL_Salud. Para ello iremos a 



 

File > New file > Examples > DSLsalud Diagram 

Escribimos el nombre de nuestro nuevo diagrama, en este caso será default dentro de nuestro proyecto test. 

 

 

Esto último nos creará: 

- un archivo que contendrá nuestro modelo default.dslsalud (siendo .dslsalud la extensión relacionada a nuestro 

metamodelo que se llama “dslsalud”) 

- un archivo que contendrá nuestro diagrama default.dslsalud_diagram (que será el diagrama asociado a nuestro 

modelo) 

 

 Otra posibilidad hubiera sido crear solamente nuestro modelo vía texto desde File > New file > Other > Dslsalud 

Model. Lo que nos crearía sólo el archivo default.dslsalud y deberíamos editar escribiendo sobre el mismo 

directamente código XML. 



 

Con esto tendremos listo el proyecto y archivos necesarios para comenzar el desarrollo de nuestro modelo default. 

A la izquierda tendremos la visualización de los modelos y diagramas que tengamos dentro de nuestro proyecto. 

En el centro tendremos la ventana de edición gráfica de nuestro modelo. 

A la derecha tendremos la paleta de opciones disponibles para crear nuestro modelo. La misma estará dividida en Entities 

y Connections. 

 

Ahora sólo nos restará dibujar nuestro modelo utilizando herramienta de la paleta.  

Todo lo que se “dibuje” además será mapeado directamente a nuestro modelo default.dslsalud de forma textual. 

 



 

Código ejemplo default.dslsalud 
 

 

 

Código ejemplo default.dslsalud_diagram 
 

 


